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1. Introduction:

This document is prepared as reference to boot Windows Embedded Compact 7 image on WEGA 
board. All the three methods, i.e boot from SD-Card, Boot from NAND and Internal 
EMAC(Ethernet) are documented here.

Visual Studio provides various options for developing applications for Windows Embedded 
Compact 7, here, reference is provided to code a sample application using Visual Studio 2008 
Professional Edition and then deploy on the WEGA board.

1.1. Target Setup:

Before starting with the boot process, first do necessary hardware setup for the WEGA Board i.e 
establish UART connection between Host Computer and device, select power adapter of +5 volts 
and 2 amperes to power up WEGA Board.

1.2. Host Setup: 

1.2.1 Putty Console:

In order to carry boot operations on WEGA Board we need serial console to get boot messages 
from device. Here we are using console software known as “Putty”.
Download “Putty” from the below link.

http://the.earth.li/~sgtatham/putty/latest/x86/putty.exe

 Go to the folder where the file is saved and double click on putty.exe file to start executing 
it.
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 Click on “Serial” radio button to use putty as serial console.

 Modify the defualt “COM1” to the COM port that you are using to communicate with the 
device. Also, change the default baud rate to “115200”. Here for the demo purpose the 
COM selection is done for “COM10” since it is the port currently used for communication.
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 After the changes has been done click on button “Open” to open the serial console.
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2.  Boot from SD-Card:

2.1.  Software Requirements:

Bootable SDCard preloaded with the following files:
●   MLO
●   EBOOTSD.nb0
●   NK.bin

2.2.  Hardware Requirements:
● WEGA Board
● Serial Cable (as communication channel between board and computer)
● Power Adapter (to power-up board)
● SDCard.

Firstly do the necessary hardware setup to carry out this operation, like setting the jumper settings 
(for WEGA Board pins 3-4 of jumper JP5 should be connected to boot from SDCard) and insert the
SDCard in respective slot provided on the board. Thereafter plug in the power cable to the board 
and start with the procedure as below.

2.3.  Procedure:

 Hit spacebar before the counter expires to get “Main Menu”, if you fail to press spacebar, 
then press “Reset” button on board and repeat the same procedure again.
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 Once you hit spacebar you will get “Main Menu” as shown

.

 Before starting with the procedure it is important to enable the flashing of “NK.bin” image. 
To perform this  task press “5” to select option “[5] Flash Management”.
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 Press “8” to select option “[8] Enable flashing NK.bin” and then press “y” when asked for 
conformation.

 Press “2” to select option “[2] Select Boot Device” option as Selection. After selecting 
option [2] you will get menu to select boot device as shown below.
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 Press “2” to select option “[2] NK from SDCard FILE” to enable SDCard as booting device.
On successful selection, a message “Boot device set to NK from SDCard FILE” will be 
displayed on the screen, and you will be directed back to “Main Menu”.

 Save your settings by pressing “7” to select option “[7] Save Settings”.
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 Once you press “7” you will be asked to confirm your selection. Here press “y”. On 
successful selection, a message “Current settings have been saved” will be displayed on 
the screen, and you will be directed back to “Main Menu”.

 Press “0” to select option “[0] Exit and Continue”, after this the booting process will start 
automatically.

NOTE: Booting process will take some time, please do not disconnect power supply or reset the 
board, since this will cause booting process to terminate.
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Below is shown the series of screen shots of booting process, last screenshot shows the booting 
process completed successfully.
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This completes the booting process from SDCard.
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3.  Boot from NAND:

3.1.  Software Requirements:

Bootable SDCard with the following images:
● MLO
● EBOOTSD.nb0
● XLDRNAND.bin
● EBOOTND.bin
● NK.bin

3.2.  Hardware Requirements:

● WEGA Board.
● SDCard (with above mentioned files)
● Power cable (to power up the board)

This process consists of two parts, Downloading images from SDCard to NAND and then 
Booting from NAND. 

3.3.  Procedure:

3.3.1.  Downloading images from SDCard to NAND:

For the first part of this process, since images from SDCard has to be downloaded in 
NAND, hence required setup for SDCard needs to be done (for WEGA Board short pins 3-
4 of jumper JP5 and then insert SDCard in the respective slot on board.) 
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3.3.1.1  Download “  xldrnand.bin  ”:

 Hit spacebar before the counter expires to get “Main Menu”, if you fail to press 
spacebar, then press “Reset” button on board and repeat the same procedure 
again.

 Once you hit spacebar you will get “Main Menu” as shown.
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 Before starting with the procedure it is important to enable the flashing of “NK.bin” image. 
To perform this  task press “5” to select option “[5] Flash Management”.

 Press “8” to select option “[8] Enable flashing NK.bin” and then press “y” when asked for 
conformation.
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 Press “5” to select option “[5] Flash Management” to start with the procedure of 
downloading first file to NAND. After you press “5” you will get menu “SDCard 
Settings” as follows.

 Press “2” to select option “[2] Enter Filename” to specify the name of first file to be 
downloaded in the NAND. 
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 Now type “xldrnand.bin” to specify the respective file and hit “Enter”.

 Press “0” to select “[0] Exit and Continue”.
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 Now that the name of image to be downloaded in NAND is specified, next we need 
to specify the device to locate the required file. Hence press “2” to select option “[2] 
Select Boot Device”.

 Press “2” to select option “[2] NK from SDCard FILE”.
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 Save your settings by pressing “7” to select option “[7] Save Settings”.

 Once you press “7” you will be asked to confirm your selection. Here press “y”. On 
successful selection, a message “Current settings have been saved” will be 
displayed on the screen, and you will be directed back to “Main Menu”.
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 Press “0” to select option “[0] Exit and Continue”, after this the downloading 
process from SDCard to NAND will start automatically and after successfully 
download you will get message “INFO: XLDR/EBOOT/IPL downloaded, spin 
forever”. 

This completes the download process for first file “xldrnand.bin” from SDCard to NAND.

Procedure of downloading remaining two files namely “ebootnd.bin” and “nk.bin” is 
exactly similar as mentioned above, below provided are the screenshots for the 
downloading process of these two files.
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3.3.1.2.  Download “  ebootnd.bin  ”:

 Reset board and hit spacebar before counter expires.

 Select option “[5] SDCard Settings”.
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 Select option “[2] Enter Filename”.

 Enter filename as “ebootnd.bin” and press “Enter”.
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 Select option “[0] Exit and Continue”. 
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 Select option “[2] Select Boot Device”.

 Select option “[2] NK from SDCard FILE”.
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 Select option “[7] Save settings” and then press “y”.

 Select option “[0] Exit and Continue” and downloading will complete.

This completes with downloading of file “ebootnd.bin” from SDCard to NAND.
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3.3.1.3.  Download “  NK.bin  ”  :

 Reset board and hit spacebar before counter expires. 

 Select option “[5] SDCard Settings”.
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 Select option “[2] Enter Filename”. 

 Enter filename as “nk.bin” and press “Enter”.
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 Select option “[0] Exit and Continue”.

 Select option “[2] Select Boot Device”.
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 Select option “[2] NK from SDCard FILE”.

 Select option “[7] Save Settings” and press “y”.
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 Select option “[0] Exit and Continue” and the downloading process of file “nk.bin” 
will start automatically, wait till the download is completed successfully.

This completes with downloading of file “NK.bin” from SDCard to NAND.

------------------------------------------------------------------------------------------------------------------------
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Once all of the three files:
1. xldrnand.bin
2. ebootnd.bin
3. nk.bin
are downloaded successfully in NAND, then disconnect the power cable of your board,
do the necessary jumper settings for NAND booting (for WEGA Board – to boot from 
NAND remove the jumper 1-2 and 3-4) and detach the SDCard from the board.
After these settings are been done, then plug in the power cable to board to start with 
procedure of Booting from NAND. 

------------------------------------------------------------------------------------------------------------------------

1.2.2.  Boot  from  NAND:

 After power plug in hit the spacebar before the counter expires, if you fail to do so, 
then perform hardware resetting of board and do the same process again. 
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 Press “2” in order to select option “[2] Select Boot Device” to specify where to find 
OS Image “NK.bin” to start with booting process.

 Press “2” to select option “[2] NK from NAND” so as to specify the NAND as location to 
find OS Image.

NOTE: Since we have modified the jumper settings and detached the SDCard, “NK from SDCard 
FILE” will not be available.
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 Press “7” to select option “[7] Save Settings” so as to save the modified settings, and then 
press “y”.

www.phytec.in 34 Revision no. 1.0



 Press “0” to select option “[0] Exit and Continue” so as to exit “Main Menu” and start with 
the booting process.

NOTE : Boot process will start automatically, please wait till the boot process is completed, do not 
plug out the power cable or “Reset” the board, since this would cause the boot process to 
terminate.

www.phytec.in 35 Revision no. 1.0



This completes the boot process from NAND.
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4. Boot from Ethernet :

NOTE: Here the explanation is provided, assuming that precompiled NK.bin is available with you, 
this section does not include procedure for compilation of source bsp to generate NK.bin.

4.1. Software Requirements:
1. NK.bin file
2. Visual Studio 2008 Professional Edition.
3. Service Pack 1 for Visual Studio 2008.
4. Windows Embedded Compact 7.

4.2. Hardware Requirements:
      1. WEGA Development Board.
      2. Ethernet Wire.
      3. SDCard preloaded with image of “ebootsd.nb0” and “MLO”.

Before starting with the process, establish connection between board and host computer via 
Ethernet cable. Insert SDCard in the respective slot on board. Short pins 3-4 of jumper JP5, and 
then connect power cable to power up the board.
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 Open new instance of Visual Studio, and then click 
             File → Open → Project/Solution

 Browse to the folder containing “NK.bin” file, select the file, and click “Open”.
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 Upon the successful selection, you will find selected image in “Solution Explorer” window.

 Now before starting with the process, the ip address of host machine and device needs to 
be changed so as they fall in same domain.
Hence change the host ip address respectively, example is shown below
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 Once the host ip address is set it is also important to set device ip address. Open putty 
serial console and hit spacebar before the counter expires.

 In order to see the device ip address and other information of your device, after getting the 
“Main Menu” press “1” to select option “[1] Show Current Settings”.
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 Now to change the ip address of your device, hit “Enter” to return back to “Main Menu”, 
and press “4” to select option “[4] Network Settings”.

 Press “6” to select option “[6] Set IP address” and enter the desired ip address.
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 After entering the ip address, hit “Enter” to go back to “Network Settings” Menu.

 Press “7” to select option “[7] Set IP Mask” and then enter necessary IP mask, in this 
example we enter mask address as 255.255.255.0.
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 After entering ip mask address hit “Enter” to go back to “Network Settings” Menu.
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 Press “8” to select option “[8] Set default router” and then enter default router address, in 
this example we enter router address as shown.

 After entering default router address hit “Enter” to go back to “Network Settings” Menu.
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 Press “1” to select option “[1] Show Current Settings” so as to verify the changes.

 Hit Enter to go back to “Network Settings” Menu and then press “0” to select option 
“[0] Exit and Continue” so as to exit current menu and go back to “Main Menu”.
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 Press “5” to select option “[5] Flash Management”.

 Press “8” to select option “[8] Enable flashing NK.bin” and then press “y” when asked for 
conformation.
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 Now to save the changes, press “7” to select option “[7] Save Settings” and then press “y” 
as conformation of selection.
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 Now that the ip address of both host machine and device is set appropriately, the procedure
for downloading NK.bin can be started. Go back to the Visual Studio window, click on 
“Target” and then select “Connectivity Options”.
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 Clicking “Connectivity Options” in “Target” list will open window “Target Device 
Connectivity Options”, in this window, under “Device Configuration” click “Add Device” 
to add new device. Enter desired name for device under “New target device name”, also 
in the drop down list of “Associated OS Designs/SDK (Optional)” select “Windows CE”. 
And then click “Add”.
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 “Target Device” will be set with the provided name. Now click on the “Settings” button of 
“Kernel Download” column. This will open “Ethernet Download Settings” window.
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 In order to establish connection between device and host, our device needs to be 
recognized by host application, i.e device name needs to be appear under the “Active 
target devices “ in order to achieve this,  go back to putty console, press “2” to select the 
option “[2] Select Boot Device”.

 Press “1” to select option “[1] Internal EMAC”.
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 Then press “7” to select option “[7] Save Settings” and then press “y” when asked for 
conformation.

 Press “0” to select option “[0] Exit and Continue”. Here in the log message device name 
would be displayed as shown below.
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 Now go back to “Ethernet Download Settings” window. Here the entry with the device 
name  will be displayed once the application receives the “Sent BOOTME to 
255.255.255.255” from device. Upon receiving the device name entry, click on it so as to 
select it and then click “Apply”. 
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 After click on “Apply” in “Ethernet Download Settings” window, the device name would 
appear under “Kernel Download” and “Kernel Transport” in “Target Device Connectivity
Options” window.
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 After the KITL connection is established, the downloading of “NK.bin” image can be 
started. To do this, click “Target” and then select “Attach Device” from the list. This will 
open “Device Status” window and the downloading will start automatically.
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 Log message of downloading “NK.bin” can also be seen in putty console while the 
downloading is going on. Wait for the download to complete.

This completes Boot from Ethernet. 
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5. Accessing device contents through USB-OTG connection.

In order to access the contents of the device through USB-OTG, we need tool called “Windows 
Mobile Device Center”.
Download and install from the link:

● for 32 bit Windows 7: http://www.microsoft.com/en-in/download/exe-validation.aspx?id=14

● for 64 bit Windows 7: http://www.microsoft.com/en-in/download/exe-validation.aspx?

id=3182

 After the software has been downloaded and installed. Then open the application by double
clicking on it.

 After the device has booted successfully, then connect device with the host computer 
through USB-OTG connection and you will get Connecting message as below:
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 After the connection has established successfully then application will show the 
“Connected” message.

 Now click on option “Connect without setting up your device”.

 After previous click, you will get the below screenshot.

 Select option “File Management” and click on option “Browse the contents of your 
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device” to access the device as drive.

With this the USB-OTG connection with the device is completed, this connection would be used in 
further manual to download the application from Host to the device.

6. Sample Application development
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6.1. Creating Project.

This section will guide you to develop the simple Visual Basic application that will send some string
from target device to Host console over UART connection.

In order to develop the application Visual Studio 2008 Professional Edition (full version) is 
required to be installed on the development computer. 

 To begin with development, open the Visual Studio 2008.

 To develop application we need to first create new project. To create new project click on 
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File → New → Project

 This is open the “New Project” window, here under “Project types” listbox expand the 
option “Other Languages → Visual Basic → Smart Device”, after clicking on the option 
“Smart Device” select “Smart Device Project” in “Templates” window. 
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 Provide any desired name for your application in the “Name:” textbox, browse to assign the
folder where you want to keep application code and supporting files, and then click on 
button “OK”.

 After clicking “OK” for “New Project” window, the “Add New Smart Device Project” 
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window would pop out, here in this window select the target platform for application as 
“phyCORE-AM335x”.

 Next, select the desired .NET Framework version for which you want to build the 
application, here in this application we are using  “.NET Compact Framework Version 
3.5”.

 Then in the “Templates” subwindow select “Device Application” by clicking on it, and then
click button “OK”.

6.2. Developing project.
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 After clicking on “OK” in “Add New Smart Device Project” as in previous screenshot, your 
development enviroment would be ready for the development process. 

 As in the below screen, under the “Solution Exporer” window, your created application i.e 
“Demo Application” could be seen. 

 If “Solution Explorer” window is not visible, then click on “View → Solution Explorer”, 
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similarly, if “Toolbox” window is not visible, then click on “View → Toolbox”. Toolbox 
window provides the set of visual contents required to create and application through drag 
and drop functionality.

 You can resize the Form1 to make it more compact as shown. From the Toolbox search 
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for “Button”, drag and drop the control in your form, you can then resize the shape of 
control and align it as per requirement. Right click on the control and select option 
“Properties”, this will open the Properties window.

 “Properties” window below provides properties of the particular control, which can be 
modified as per required. 

 Now, expand the “Font” and in the text option change the default text with “Open Port” and
hit Enter. Once this is done the same text would be the text on Button1 control.

 Follow the similar procedure to add two more buttons i.e Button2 and Button3 controls in 
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your form and edit there “Text” field in Properties windows with “Send String” and “Close 
Port” respectively. 

 Now search for “SerialPort” control from Toolbox, drag and drop it in the “Form1”, control 
would appear at the bottom of “Form1.vb[Design]” with name “SerialPort1”, 

 If the “Properties” window does not appear, then right click on the “SerialPort1” and select 
“Properties”. 

 In this Properties window change the default BaudRate to “115200” and default PortName 
to “COM0”. Once done with he changes hit Enter.
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 Double click on the Button1 control in “Form1”, this will open the new window named 
“Form1.vb”. In this window the “Button1_Click” function would be created by default, 
inside this function you need to provide the code to state the action that has to be taken 
when Button1 is pressed.

 Now inside the function Button1_Click() add the following code:

If SerialPort1.IsOpen = True Then
            MsgBox("COM0 is already open", MsgBoxStyle.Exclamation)

        Else

            SerialPort1.Open()

        End If

 Similarly add the code inside Button2_Click() function as:

SerialPort1.Write("Hello World")

 And, inside Button3_Click() function as:

If SerialPort1.IsOpen = False Then
            MsgBox("COM0 is already closed", MsgBoxStyle.Exclamation)

        Else

            SerialPort1.Close()

        End If
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6.3. Build the Project

 Before building the project it is important to save the work done. Click on File → Save All 
to all the changes done in the project.
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 Once all the work has been saved, then compiling can be started, for this, click on option 
Build → Build Demo Application 

 If the project is builded successfully i.e without any errors then notification will be shown on 
“Output” window as follows. Output window shows the build log which is used to view and
locate errors or warnings in build process.

 If the project is builded successfully then, the executable file of the same is generated. To 
locate the .exe file, go to the folder path which was choosen while creation of the project. 

 In this example, the project folder is located at path “D:\Device Apps”. In this folder there 
would be another folder with same project name, track the Debug folder which contains 
.exe file of your project, with the path as follows:

D:\Device Apps\Demo Application\Demo Application\bin\Debug\Demo Application.exe
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6.4. Deploying and Executing your project on target device.

Before deploying the project on the device the device must be running Windows Embedded 
Compact 7 on it.

Also the application requires the LCD connection with the board using which the application will 
be executed and tested.

For board bring-up, follow the documentation of Booting process, 

After the board is booting successfully, and display on LCD, then connect device host with USB-
OTG, refer the documentation on “Accessing device contents using USB-OTG connection”.

This connection will be used primarily to copy the application from host to target device.

Once the connection is established, copy the executable from host and paste in 
“\Application Data” folder.

While coying the file you might get warning window for copy operation, click on “Yes” to proceed 
with the copying.

Connect the Device to Host with through UART connection, with COM0 of device connected to any
running COM port of Host. Open the serial terminal i.e Putty to get the string on serial console. 
Open the console on with baudRate set as “115200”. 
Now, manually go to the “Application Data” folder from LCD, double click on executable, this will 
open up the Form1. Click on Button “Open Port” from the form to open the port for 
communication, Then click button “Send String”, with this the string “Hello World” would be visible
on the console of Host.

This completes the simple application development from Windows Embedded Compact 7 using 
Visual Basic.
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Get the dialog going ...

                 ... and stay in touch

India
PHYTEC Embedded Ltd. 
#16/9c 3rd Floor, 3rd Main

8th Block, Opp. Police Station
Kormangala, Bangalore-560095

Tel.: +91-80-40867046
www.phytec.in

Germany
PHYTEC Messtechnik GmbH

Robert-Koch-Straße 39
D-55129 Mainz

Tel.: +49 6131 9221-32
Fax: +49 6131 9221-33

www.phytec.de
www.phytec.eu

America
PHYTEC America LLC

203 Parfitt Way SW, Suite G100
Bainbridge Island, WA 98110

Tel.: +1 206 780-9047
Fax: +1 206 780-9135

www.phytec.com

France
PHYTEC France SARL
17, place St. Etienne

F-72140 Sillé le Guillaume
Tel.: +33 2 43 29 22 33
Fax: +33 2 43 29 22 34

www.phytec.fr

..................................We are looking forward to hearing from you!..................................
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